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Installing Folio Views and Infobase (General) 
 
Q. When I run the Folio Views installation I get an iKernel.exe error message? 
 
A. The Advancing Physics CD-ROM uses InstallShield to install Folio Views, Modellus, Scion Image and 
WorldMaker (A2 CD-ROM). The iKernel.exe message is an InstallShield error message that can occur for a 
several different known reasons: 
 
• Long pathnames/filenames. The problem sometimes occurs when you run the installation from a long 

network path on a machine running early versions of Windows 95 and Windows 98 or on networks 
running older versions of Novell. Modifying the path to consist of folders containing only 8 characters 
usually solves the problem. Another known solution is to ensure that the "Disable long name precautions 
for old programs" checkbox is checked in the Control Panel under [System>Performance>File System 
and troubleshooting].  

• Low available memory. You can reduce the memory demand of the install substantially by exiting the 
Install Manager and running the setup.exe inside the \Folio\ folder on the CD-ROM directly. 

• Low available disk space in the TEMP folder used by Windows on your system. Try cleaning your 
Windows TEMP folder. 

• Virus guard. Try switching off the computer’s virus guard during the installation. 
• Dirty or scratched disk. Check the CD-ROM for dirt or scratches. 
 
Q. The Folio Views installation fails with the error message: “Setup Failed to run installation. The 
argument string passed to DosExecPgm is not correct.” 
 
A. This is an InstallShield error message. The following steps have helped in some cases (all steps are 
required): 
1. Clean the Windows TEMP folder. Remove all folders that have been left behind by previous setups. 
2. Reboot. 
3. Run ScanDisk. Even if it doesn't report any errors on the drive, it seems to fix some disk problems. 
Ensure your computer’s virus guard is disabled while following these steps and when you try to install 
again. 
Other things you can try: 
• Delete the folder c:\Program Files\Common Files\InstallShield\engine and try again. 
• Reinstall Internet Explorer 5. (IE5 is shipped on the Advancing Physics CD-ROM.) 
 
Q. Trapped in uninstall loop. I uninstall Folio Views or Modellus or Scion Image or WorldMaker, but 
when I try to install it again the installer informs me that it is already installed. Uninstalling again 
does not remedy the situation. 
 
A. This can happen after a fault in installation such as power failure or a CD misread. To fix the problem, 
you need to remove InstallShield's uninstall information for the relevant application manually. Proceed as 
follows: 
1. In Windows Explorer, locate the folder c:\Program Files\InstallShield Installation Information. This is a 

hidden folder. If you cannot see it in Explorer go to the View menu and choose Options... > View tab 
(on Windows 2000/XP, go to Tools menu and choose Folder Options… > View tab). In the Hidden files 
section (Hidden files and folders on Windows 2000/XP), select the radio button next to Show all files 
(Show hidden files and folder on Windows 2000/XP). Press OK and you should now be able to see the 
InstallShield Installation Information folder.  

2. Inside this folder are folders for the applications you have installed so far. The folder names are long and 
a mixture of digits and letters.   The table below lists the InstallShield Installation Information folder 
names for all the AP applications.  

3. In Windows Explorer, locate the folder that refers to the application that is trapped in the uninstall loop.  
4. In Windows Explorer carefully delete only this single folder. Now you should be okay to re-install the 

software. 
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Application Installshield Installation Information folder name 
AS Student Standalone bb068861-0797-11d3-9ded-004095d03841 
AS Student Network bb068861-0797-11d3-9ded-004095d03841 
AS Student Network Client 17215ae0-440a-11d3-9ded-00104bb25a1b 
  
AS Teacher Standalone 5c676d7f-ea0f-11d3-80cc-00c04fa4e18d 
AS Teacher Network  5c676d7f-ea0f-11d3-80cc-00c04fa4e18d 
AS Teacher Client 2722b3d7-ea02-11d3-80cc-00c04fa4e18d 
  
Modellus (AS and A2) d60c87e0-eaec-11d3-80cd-00c04fa4e18d 
Scion Image 7e878229-0978-11d4-b5ec-00c04f0a9adc 
World Maker 9173bc52-13b2-11d5-b642-00c04f0a9adc 
 
A2 Student Standalone 76ef1661-149e-11d5-b644-00c04f0a9adc 
A2 Student Network 00bab9e5-6ee5-11d4-b60f-00c04f0a9adc 
A2 Student Network Client 81f7f69a-6c75-11d4-b60f-00c04f0a9adc 
  
A2 Teacher Standalone 76ef166b-149e-11d5-b644-00c04f0a9adc 
A2 Teacher Network  c58204c4-6c51-11d4-b60f-00c04f0a9adc 
A2 Teacher Client c58204b2-6c51-11d4-b60f-00c04f0a9adc 
 
 
Q. My install hangs at the end, after the Readme.txt is displayed in Notepad, with the message: 
“Creating folders and shortcuts, please be patient". 
 
A. Ending the task terminates the hang and then the application should run fine. There is usually no need to 
reinstall. To end the installation task: 
1. Press Ctrl-Alt-Del and choose Task List… or right-click on the taskbar and choose Task Manager from 

the popup menu.  
2. In the Task Manager, choose the Applications tab, click on the installation application and press the 

Delete key to end the task.  
3. Reboot and then try to run the application. 
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Installing Folio Views and Infobase (Networks) 
 
Q. When I start Folio Views I get an error message: “Unable to open the infobase. (245, 1)”. 
A. This problem can occur for the following reasons: 
• In a network environment the user does not have Read-Write-Execute rights to the LCF. To solve the 

problem, ensure that users have Read-Write-Execute rights to the LCF.  
1. To give your users Read-Write-Execute rights to the LCF file, locate the file in Windows Explorer, right 

click on it and choose Properties from the popup menu.  
2. Amend the Security Permissions to give your users “Full Control”. If you are manually copying the LCF 

file from the CD-ROM to replace a corrupt or deleted LCF, first remove the Read Only attribute on the 
Attributes section of the General tab. 

 
• The LCF has either been deleted or moved to a different location. To solve this problem, replace the 

LCF with a copy of the original file from the CD-ROM (\Folio\Rights\ folder).  
• The LCF has become corrupted by users not closing Folio Views correctly. If Folio Views is running, 

simply switching off the computer will corrupt the LCF file.  
To solve this problem, replace the LCF (see the CD-ROM InstallReadme.pdf for details of where this 
might be) with a copy of the original file from the CD-ROM (\Folio\Rights\ folder).  
Make sure that your users understand the importance of NOT switching off computers when Windows 
and Folio Views are running. 

• You have installed as Administrator, but you see the server drive as its UNC pathname (e.g. \\MYPDC\) 
and your users see the drive as a mapped drive letter. All path information of the install, including the 
desktop shortcut, has been specified in UNC terms that your users may not understand. 

 
Q. When I start Folio Views I get the error message: “Unable to open Infobase. Insufficient privileges 
to complete operation”. 
A. This problem occurs if the LCF has the wrong permissions or has become corrupted by users not logging 
out correctly in a network environment. To solve the problem, ensure that users have Read-Write-Execute 
rights to the LCF and, if necessary, replace the LCF with a copy of the original file from the CD-ROM. See 
previous question for details. 
 
Q. When I run the installation on to a network drive from a client machine I get an error message 
telling me I do not have sufficient disk space and yet I have over 1GB free? 
A. This is usually caused by the network drivers installed on your PC being out of date. To solve this 
problem, check with your network supplier to make sure you have a recent set of drivers.  
 
Q. RM Connect Network Installation using the packages provided on the CD-ROM. I get "cannot 
create new policy fragment" during the package allocation step. 
 
A. This is to do with the fact that the packages on the CD-ROM are Read Only when you copy them to your 
server hard drive.  
When you have copied the packages to the server hard drive, first remove the Read Only attribute from all 
packages before allocating them.  
The simplest way to do this is to use the DOS command Attrib -r A* /s. This will remove the Read Only 
attribute (-r) from the entire contents (/s) of all (A*) Advancing Physics packages. The file in each package 
that actually causes the problem is the .usr file in the folder \station\pkgdat\[packagename]\. 
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Q. Installation on NT Network (AS 2000 CD-ROMs only). Users get an incorrect Folio Views 
interface. 
 
A. This is because, on the AS 2000 CD-ROMs, the Folio Views interface information is placed in the 
HKEY_CURRENT_USER part of registry during installation. Since installation is performed as 
Administrator, the interface information becomes integrated into the Administrator’s registry but not into 
that of the Users.  
 
To resolve this issue, go to the Advancing Physics Web site 
(http://advancingphysics.iop.org/products/support.html), where you can obtain the Advancing Physics AS 
2000 Service Pack 1 Registry Update patch and full instructions. 
 
Q. Installation on CSE Network (AS 2000 CD-ROMs only). Users get an incorrect Folio Views 
interface. 
 
A. Because CSE networks run mandatory profiles, manually fixing the User profile by merging the 
Advancing Physics registry files does not provide a permanent fix – the information is lost when the user 
logs out.  
Here is how CSE technical support recommends implementing a fix: 
1. Create a directory on drive P: called IMPORT and then copy the registry files from the CD’s 

\Folio\Registry\ directory to P:\import.   
2. Next create a launch script for the application. To do this, run Resource Manager and go to the 

Advancing Physics application.  Click on the icon, double click on Details then go to the launch script. 
In the top section (student’s CD-ROM) add:  

run c:\windows\regedit.exe /s P:\Import\AdvPhySS.reg 
This will import the Advancing Physics registry information into the registry whenever Folio Views is 
launched by a User. 

3. In addition you need to set up a launch script for the application to run the registry file that contains the 
interface information each time a user uses the application.  

4. First copy the file \Folio\Registry\AdvPhySS.reg (Student’s CD-ROM) or 
\Folio\Registry\AdvPhyST.reg (Teacher’s CD-ROM) from the CD-ROM to P:\Import\.  

5. Then go to the Launch Script page of the Application Information form and type in the following launch 
script:  

run c:\windows\regedit.exe /s P:\Import\AdvPhySS.reg 
(Substitute AdvPhySS.reg with AdvPhyST.reg if working on the Teacher’s CD-ROM.) 
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Using Folio Views  
 
Q. I have carried out a Standalone Maximum install on Windows ME/XP, but when running the Folio 
Views software, performance is very poor with long waits and lots of hard disk activity. 
 
A. The problem relates to the Windows ME/XP System Restore utility. There are 2 solutions:  
The easiest solution is to make the Folio Views infobase on your hard disk Read Only. The infobase 
typically resides in c:\Program Files\Advancing Physics\Nfo\ (AS 2000 CD-ROM).  
1. Locate the infobase (e.g. AdvPhyST.nfo on the Teacher’s AS CD-ROM) using Windows Explorer, right 

click on the file and choose Properties from the popup menu.  
2. Check the Read-only checkbox on the General tab under Attributes. [Other infobase names: 

AdvPhySS.nfo (Student’s AS CD-ROM), AdvPhy2S.nfo (Student’s A2 CD-ROM), AdvPhy2T.nfo 
(Teacher’s A2 CD-ROM).] 

 
The other solution is to disable the System Restore utility. To do this, right click on My Computer and 
choose System>Properties>Performance>File system>Troubleshooting and disable the System Restore. 
Click on Apply before closing, to save. 
 
Q. My shadow file has become “locked” so that I can no longer write to it. I can type in new text, but 
when I attempt to save the shadow file I get the message: “You have performed an illegal operation. 
Views caused an exception 03h in module Fcsrv4b.dll…”. 
 
A. Folio Views shadow files can on occasion become locked. The usual cause is a severe drop in power at 
the moment when the shadow file is saved e.g. a laptop battery running low or a low power incident on the 
electrical circuit to which your computer is attached. Running shadow files from floppy disk is also 
implicated. 
 
The official Folio guidelines to salvage a locked shadow file are as follows: 
1. Exit Folio Views. If this is on a network, make sure all users exit Folio Views. 
2. Start Advancing Physics again and open the shadow file. 
3. Exit Folio Views. The purpose of this is to clear any remnant lock (*.lck) file that may have been left 

after the Folio error and crash. 
4. Start Advancing Physics again and open the shadow file. Try editing the shadow file. 
5. If Folio won't let you edit because the file is in use by another user (or yourself!), exit Folio Views. 
6. In Windows Explorer, go to the folder where the shadow file lies. You should see a .lck file with the 

same file name as your shadow file. Delete this .lck file. There could be other remnant files there too: 
shadowfilename.000, shadowfilename.001, shadowfilename.101 etc. Delete these too. 

7. Start Advancing Physics again and open the shadow file. Try editing the shadow file again. 
 
Folio shadow files can, however, become permanently locked. You will be able to read them, but you will 
not be able to edit and save them.  
 
Here are some brief hints for using shadow files: 
• Avoid low power situations, especially on laptops. 
• Avoid running shadow from floppy disk. Use floppy disk as a transfer medium, but copy shadow files to 

the local hard disk before editing them. 
• Study the section on annotations in the infobase: How to>Use this CD-ROM>Annotating. Please take 

special notice of the warnings given. 
• Back up your shadow files regularly to avoid losing too much work in the event of locking. 
 
Q. I have deleted a note from my shadow file and resaved the shadow file, but the text from the 
deleted note still appears in the Annotation Search dialog box. 
A. This is a bug in Folio Views. Even though the annotation text has been deleted from the shadow file, it 
remains in Folio’s search index for the shadow file. However, if you do search on one of the deleted words, 
you won’t actually get any hit results, unless that word appears elsewhere in the shadow file. 
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Q. When I try to create a new bookmark, by pressing the Bookmark button or by choosing 
Bookmarks… from the Tools menu, I get the message: “Unable to create new bookmark. Insufficient 
security privileges to complete operations. (904,3)” 
A. Bookmarks can only be used in shadow files. But there is a bug in Folio Views so that the Bookmarks 
button and menu item appear enabled even if you do not have a shadow file open and, in this case, you get 
the error message above if you try to use them. Bookmarks work fine in shadow files. 
 
Q. The CD-ROM numbering scheme for items is not unique. When I use the Find using a Reference 
Code box on the Focused Search I get more than one search hit. 
A. The Reference Codes in Advancing Physics are not unique. To use the Focused Search efficiently you 
need to know the Resource Type (e.g. Question), the Reference Code (e.g. 20s) and the chapter (e.g. 2) in 
which the resource you are looking for lies. 
 
Q. My OHT printouts are too small. How can I enlarge them? 
A. From How to>Use this CD-ROM>Extracting information>Printing:  
1. The best way to [print OHTs] is to print out the diagram or image from the Object pane. 
2. Press the Print button in the toolbar to bring up the Print dialog box.  
3. Select the Print Object tab at the bottom left of the Print dialog box. A preview of the diagram or image 

is shown on the Print Object tab. Press OK to print the item. 
4. Note: if you have not selected the Print Object tab on the Print dialog you will print out the small version 

of the OHT shown in the Document pane, because the default tab is Print Document. This is the usual 
cause of printouts being too small. 

 
Q. How can I change the margins and headers/footers on the pages I print? 
A. You can alter the margins in Page Setup (File>Page Setup). However headers and footers are defined in 
the infobase. If you want to change them you can set up a shadow file solely for printing from and then alter 
the Page Setup details for headers and footers as you wish.  
 
Q. How can I print a list of all the resources on the CD-ROM? 
A. Choose Print from the File menu to bring up the Print dialog box and select the Print Contents tab. There 
are three radio buttons, the most useful of which are All (prints the entire contents list) and Branch (prints 
the contents of the currently selected branch). Press OK to print. 
 
Q. I cannot print the Materials Selection Chart OHTs (Display Material 15O) in chapter 4. 
A. These OHTs are quite large files (~10MB each), and some users have trouble either displaying the OHTs 
in the Object pane ready for printing, or actually printing the OHTs themselves.  
The problem is caused by low memory situations. In the first instance, try closing all other applications, 
restart Folio Views and try again.  
If this does not resolve the problem, you may be able to address the virtual memory setup on your machine 
(see Windows manual for details), but your best solution might be simply to try printing the OHTs from a 
higher specification machine. 
  
Q. How can I hide the answers on our school networked CD-ROM? 
A. The only way of removing the answers is to create a shadow file without them in – this would be a 
tedious task. Do not forget that students only get the answers; they do not get the full worked solutions that 
are on the Teacher’s CD-ROM. 
 
Q. How can I keep an Answers popup open and scroll down a question sheet in the Document page at 
the same time? 
A. This is standard Folio Views functionality, but a workaround is to select the answers and temporarily 
copy (Ctrl+C) and paste (Ctrl+V) them across into Notepad or Word. 
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Q. Using Folio Views I find that my free hard disk space gets less and less, but I have not installed any 
new software. 
A. When you click on data links for model, graphics or other data files in the Advancing Physics Folio 
Views infobase, the relevant file is exported from the infobase and written to the Folio Views “cache” folder 
before being opened by the appropriate application.  
The cache folder is typically “c:\Program Files\Advancing Physics\Cache” (AS 2000 CD-ROM), but may be 
the Windows temp folder in some network situations.  
The cache folder will grow in size as you click on Folio Views data links. You may wish to intermittently 
empty the cache folder manually using Windows Explorer. 
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Special notes on the Additional Applications 
A number of additional applications are shipped on the Advancing Physics CD-ROMs. They all have 
different installers. Where applicable, this section highlights any special points about the installation of these 
applications and provides other information relevant to their use, including some FAQs. 
 
Modellus 
• 

• 

• 

• 

• 

The Modellus shipped on the AS CD-ROMs installs a folder called \AdvPhyAS\ which contains bitmaps 
and avi files associated with certain models that are embedded in the AS infobase. 
The Modellus Update shipped on the A2 CD-ROMs installs a folder called \AdvPhyA2\ which contains 
bitmaps and avi files associated with certain models that are embedded in the A2 infobase. This update 
is required for the A2 Modellus models to work correctly. 
The Modellus Update provided on the A2 CD-ROM updates the Modellus application shipped on the 
AS CD-ROM for use in A2. It creates a new folder of associated bitmap images for A2 models. It has a 
smart installer that detects if Modellus is already installed. If it is, the Modellus Update installer updates 
the previous installation for A2. If it isn’t, it carries out a full install of Modellus that works for both AS 
or A2 CD-ROMs.  
If Modellus is already installed, in most instances it is simplest just to run the Modellus Update. 
However, in package allocation network environments, such as RM Connect networks, it is probably 
best to deallocate the previous AS Modellus installation and then install the new Modellus Update and 
allocate that to the workstations. This way the Modellus installation is kept discrete. 
If you are short on hard disk space, and if you do not need the sample files that come with Modellus, 
you can delete them to save you 11.4MB. DO NOT DELETE the \AdvPhyAS  or \AdvPhyA2 folders, 
which contain bitmaps and avi files associated with certain models that are embedded in the infobase. 

 
Scion Image (AS CD-ROMs only) 

Requires DirectX. DirectX is commonly loaded on most versions of Windows. Having installed Scion 
Image, if you can run it without error messages, then DirectX is already installed. If you need to install 
DirectX, DirectX v6.0 is provided in Install Manager – choose Install Advancing Physics>Support 
Applications>DirectX 6.0. 

 
Cool Edit 96 (AS CD-ROMs only) 
• Cool Edit 96 is a digital sound editor shipped as shareware (in a demo version). Please note that you are 

responsible for the registration and purchase of this unique application after a short evaluation period.  
• Cool Edit 96 has now been superseded by Cool Edit 2000. Cool Edit 2000 is completely compatible 

with the Advancing Physics CD-ROMs. In order to purchase the software, you need first to download 
the Cool Edit 2000 demo from the Syntrillium web site and install it. Then you are in a position to pay 
for and register it in order to enable the full product. See http://www.syntrillium.com for purchase 
details. 

• We do not recommend the Cool Edit 2000 Lite product that is also offered when you come to register 
the software. Most of the options on the Transform menu are missing in Cool Edit 2000 Lite and they 
are needed to process sounds. 

 
Here is some more advice on how to implement Cool Edit for Advancing Physics: 
 
1. Think of Cool Edit as a piece of apparatus (that could also be effectively used for KS3 and 4). You may 

have another piece of apparatus that will give you the same ability to capture, display and process 
sounds. If so, then use it. It may be software-based, or not. Multimedia sound, oscilloscopes, 
Audioscope, Amadeus, Soundmaster, Pasco interfaces, BBC micros all enable you to do some of the 
processes possible with Cool Edit. However, at the time of writing, Cool Edit is a unique product at its 
price tag. 

2. For school use you should register Cool Edit 2000. Students working independently of the school site 
have the option of trying out Cool Edit 96 from the AS CD-ROM and then registering it if they want to 
keep it.  

3. We do not recommend using Cool Edit on a network suite of PCs, due to the potential noise levels. We 
recommend installing it on one machine in the lab, to demonstrate how to use it, to capture sounds and 
to analyse them. However, students that do not have a machine at home need access to it at school in 
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their private study time. Therefore, depending on your situation, you may need to register a second copy 
for an open access machine (we recommend fitting this with headphones). So the total cost to the 
department of deploying the potential of this software is one or two registrations. 

 
Where to find out more: 
• In the infobase, How to>Use this CD-ROM>Cool Edit>Getting started with Cool Edit gives an 

overview of the software. 
• You can search the infobase using an Exploratory Search (chapter 3; “software-based” in the Activities 

box; “PC running sound processing software” in the Free Text box) to find the eight activities for which 
Cool Edit is recommended.  

 
Q. When I click on a Cool Edit icon in the infobase, Cool Edit does not appear. Another application 
appears instead. 
A. When you click on a Cool Edit link in Folio Views, Folio Views exports a .wav file from inside the 
infobase to a cache folder on the hard disk (typically c:\Program Files\Advancing Physics\Cache\). Folio 
then asks Windows to open the .wav file and Windows opens it with its .wav-associated application.  
One of the steps in the Cool Edit installation (Audio file association dialog box) asks: “Would you like to 
use Cool Edit as the default editor and player for your audio files?” If Cool Edit does not appear when you 
click on a Cool Edit link and another application (e.g. Winamp) appears instead, either you did not accept 
this step in the install or, for some reason, the .wav association is protected on your computer (most likely on 
machines at school).  
Given the minimal install suggested for Cool Edit at school (see above), we recommend making Cool Edit 
your machine’s default editor and player for your audio files. If this is not possible at school because of the 
way your Network Manager administers the network, please see the following suggested workaround. 
 
Q. How can I enable the infobase Cool Edit links if I do not want to make Cool Edit my machine’s 
default editor and player for audio files? 
A. Follow this routine: 
1. Using Registry Editor, export a small registry file of your machine’s audio settings. The registry keys 

you need to export are in HKEY_CLASSES_ROOT. Typically the HKEY_CLASSES_ROOT \.wav key 
references HKEY_CLASSES_ROOT\SoundRec, so export the key: 
HKEY_CLASSES_ROOT\SoundRec\shell. Name the file, for example, regularaudio.reg. 

2. Install Cool Edit, accepting the Audio file association dialog box.  
3. Export the registry key: HKEY_CLASSES_ROOT\SoundRec\shell again. Name the file, for example, 

coolaudio.reg 
4. Run the regularaudio.reg file to reset the machine’s registry to what it was before the Cool Edit 

installation. 
5. Create a launch batch file to run when Advancing Physics is launched. The batch file runs regedit with 

the coolaudio.reg file, then launches Advancing Physics with the usual three-part shortcut (see 
InstallReadme.pdf for more information on this), then it runs regedit with the regularaudio.reg file when 
Advancing Physics is closed.  
Here is some example code (AS Student’s CD-ROM): 
@echo off 
regedit /s coolaudio.reg 
“[path to views]\views.exe” –cSoftware\AdvPhySS “[path to infobase]\AdvPhySS.nfo” 
regedit /s regularaudio.reg 

 
Q. When installing Cool Edit, I get a warning message saying that one of the DLLs is already in use.  
A. This problem sometimes occurs if other sound applications, such as Real Player and Creative Labs mixer, 
are either open or have auto launchers. If you experience this problem exit all the other programs, then press 
Retry. If the problem persists, press Ignore. 
 
 
WorldMaker (A2 CD-ROMs only) 
• WorldMaker is a 16 bit application that in network situations is recommended for installation on 

individual workstations.  
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The Advancing Physics WorldMaker models are in fact small database files that are held in the \Worlds\ 
folder inside the WorldMaker installation folder. For the models to work, users must have write access 
to them, so ensure that the Security Permissions of the files are set to give your users “Full Control”. If 
you ever manually copy WorldMaker files from the CD-ROM, remember to remove the Read Only 
attribute from the files before trying to open them. 

• 

• 

• 

• 

• 

• 

• 

If you need to create a desktop shortcut for WorldMaker, ensure that you enter the WorldMaker 
installation directory as the Start in/Startup path. Also ensure that no trailing slash is included at the end 
of the path. Therefore a typical correct Start in path would be: “c:\Program Files\WorldMaker”. 
While it is possible to install WorldMaker to a network hard drive so that all users run the software from 
there, it is not recommended because all users then share the model files in the \Worlds\ folder. This 
raises concerns for several reasons. Firstly, the efficacy of database file-locking has not been tested by 
us with large numbers of users sharing a model file at one time.  
Secondly, the shared (and writable) model files can then be spoiled for all users by one individual user 
changing and saving the file. This is why installation on individual workstations is recommended. 

 
Q. When I launch WorldMaker, the program displays a dialog box with an error message: “[extended 
ASCII characters], No WorldMaker (HK) file!”. 
A. This occurs of the desktop shortcut Start in/Startup folder is set to a path other than the WorldMaker 
installation folder. The default path is “c:\Program Files\WorldMaker”. 
 
Q. When I launch WorldMaker, the program displays a dialog box “FORM1” and then closes. 
A. This occurs if the desktop shortcut Start in/Startup folder includes a trailing slash at the end of the path. A 
typical correct path would be: “c:\Program Files\WorldMaker”. 
 
Q. When I try to open a model file in WorldMaker I get the message: “BDE error $2AOB. 
[PATH]\FILENAME.DB”. 
A. The model file is Read Only. WorldMaker requires write access to model files in order to open them. 
Remove the Read Only attribute before trying to open the model file again. 
 
 
Chime (AS CD-ROMs only) 

Chime is a Netscape plugin needed to run the interactive model of ferritin in chapter 5. The plugin is not 
compatible with Microsoft Internet Explorer. 

 
 
Insight (AS CD-ROMs only) 

A 15 minute time-limited demo version of Insight 2 is shipped on this CD-ROM. The software will run 
for periods of 15 minutes before a message box appears ("Demonstration version: only 15 minutes 
allowed"). Clicking OK ends your Insight session, but you can simply restart the program for another 15 
minute period.  
Insight 2 is 16-bit software, so you are likely to see truncation of long pathnames when using any dialog 
boxes that list directory structures.  
You can purchase a full copy of the new Insight 4 software on Mac/Win CD-ROM from Longman 
Logotron. See http://www.logo.com/cat/browse/science.html for details.  

 
 
Ripple Tank and Wave Superposition VB Animations (AS CD-ROMs only) 
• 

• 

• 

Both of these applications use Active X controls and Visual Basic 6. The install programs will detect 
and update older versions of these libraries on your system. This should have no negative effect on the 
operation of your computer. 
Under certain circumstances you may get a message box warning of a version conflict during 
installation. This problem normally occurs when a support library program being copied is older then the 
one already installed on the machine. In this event we strongly recommend you choose to keep the 
existing version as other applications on your machine may well be using the library file.  
We recommend taking care if you ever want to uninstall these programs (choose Add/Remove Programs 
in the Windows Control Panel). The uninstall will offer you the chance to remove the shared library 
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files. We recommend accepting the default, to keep the shared library files, since other programs may 
need them. 

 
 
PhysVis (AS CD-ROMs only) 

PhysVis is provided as a useful tool but is not directly supported by Advancing Physics. • 
• 

• 

• 

PhysVis can be run directly from the CD-ROM and needs no installation to hard drive. You can run 
PhysVis from within Install Manager by going to Install Advancing Physics>Additional Applications 
and choosing the PhysVis button, or by running the file physvis.exe in the \Additional Apps\PhysVis\ 
folder on the CD-ROM. 

 
 
WinScope (AS CD-ROMs only) 

WinScope is a PC oscilloscope provided as a useful tool, but not directly supported by Advancing 
Physics. 
WinScope can be run directly from the CD-ROM and needs no installation to hard drive. You can run 
WinScope from within Install Manager by going to Install Advancing Physics>Additional Applications 
and choosing the WinScope button, or by running the file WINSCOPE.EXE in the \Additional 
Apps\WinScope\ folder on the CD-ROM. 
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Special notes on the Support Applications 
A number of supplementary Windows applications are shipped on the Advancing Physic CD-ROMs. You 
may find these support applications useful to read the material provided on this CD-ROM, if you do not 
already have comparable tools. This section provides links to web site FAQ information relevant to their 
use. 
 
Adobe Acrobat 
The Adobe Acrobat Reader enables you to view and print PDF documents. Information regarding 
configuring the Reader and updates are available from the Adobe web site at: 
http://www.adobe.com/products/acrobat/ 
 
 
Microsoft Word Viewer 
The Microsoft Word Viewer enables you to view and print Microsoft Word Documents. Information 
regarding configuring the viewer and updates for new Word formats can be found on the Microsoft web site 
at:  
http://support.microsoft.com/support/default.asp?PR=wrd&FR=0&SD=GN&LN=EN-US 
 
Microsoft Excel Viewer 
The Microsoft Excel Viewer enables you to view and print Microsoft Excel Spreadsheets. Information 
regarding configuring the viewer and updates for new Excel formats can be found on the Microsoft web site 
at:  
http://support.microsoft.com/support/default.asp?PR=xlw&FR=0&SD=GN&LN=EN-US 
 
 
Java Runtime Environment 
You need Java Runtime Environment (JRE) to run the three Java Applets provided in chapters 4 and 5 (AS 
2000 CD-ROM) and the Java Applet provided in chapter 15 (A2 2001 CD-ROM).  
 
Please note that the "TheBike" applet suite provided in chapter 4 requires an additional setup before you can 
access its "Materials Database". Setup instructions can be found on this CD-ROM in the directories: 
\Components\Java\TheBike\Setup\Win9598\ (for Windows 95 and Windows 98) and  
\Components\Java\TheBike\Setup\WinNT2000\ (for Windows NT and Windows 2000) 
as ReadMe.txt. 
 
Configuration information and updates for Java Runtime Environment can be found on the SUN Java web 
site at: 
http://java.sun.com/products/jdk/1.2/ 
 
 
Microsoft Internet Explorer 5 
The latest version of Internet Explorer and information on configuring the software can be found on the 
Microsoft web site at:  
http://support.microsoft.com/support/default.asp?PR=ie&FR=0&SD=GN&LN=EN-US 
 
 
DirectX 6.0 (AS CD-ROMs only) 
DirectX is used by Scion Image to provide various drawing and printing facilities. Since Windows 95 and 
above commonly have DirectX 4.0 or above. If you find the version installed on your PC is older than 
version 6.0 it is worth considering loading version 6.0 which is shipped on this CD-ROM. The latest version 
of DirectX, along with compatibility information can be found at the Microsoft web site: 
http://support.microsoft.com/support/default.asp?PR=drx&FR=0&SD=GN&LN=EN-US 
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Video for Windows 1.1 (AS CD-ROMs only) 
Video for Windows has been superseded by Microsoft Media Player v6/7 (details follow). 
 
 
Windows Media Player 6.4 and 7.0 (A2 CD-ROMs only) 
We provide Media Player v6.4 (compatible with Windows 95 and Windows NT) and Media Player v7.0 
(compatible with Windows 98, Windows ME and Windows 2000) in case you do not have video software 
capable of playing the AVI files included on the Advancing Physics CD-ROMs. Readme.txt files that 
provide an overview of system requirements are included with the installers. Information on multimedia 
formats and Windows Media Player can be found on the Microsoft web site at: 
http://www.microsoft.com/windows/windowsmedia/EN/default.asp 

http://www.microsoft.com/windows/windowsmedia/EN/default.asp
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